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G Suite

Google Sheets and Google Slides

Google Sheets and Google Slides are two of the cloud-based applications that
are a core part of Google Tools. Google Sheets is a spreadsheet developing
application, which enables you to create, organize and manage data. Google
Slides is Google’s presentation application, which allows you create and format
polished presentations. This workshop outlines the foundational skills required
to create spreadsheets in Google Sheets as well as presentations in Google
Slides and will cover:

¢ Introduction to Google Drive ¢ Introduction to Google Slides
e Getting Started in Google Sheets ¢ Navigating Google Slides

¢ Navigating Google Sheets e Features of Google Slides

e Features of Google Sheets e Practice
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Introduction to Google Drive

The G Suite is a free, web-based service from Google, which allows you to save your files
online and access them from any computer with an internet connection. This service is
comprised of various applications, which are housed within a cloud-based Google Drive,
similar to a computer system, but all based online.

Google Drive allows you to create, share, and manage various files such as pictures,
documents, spreadsheets and presentations. These files may be shared, opened, and edited
by multiple users simultaneously, allowing users to see character-by-character changes as
other collaborators make document edits. Changes are automatically saved to Google's
servers, and a revision history is automatically created and stored so that past edits may be
viewed and reverted to. Google Drive eliminates the need to email or save a file to a USB drive
or other media since is it available to anyone with a device and internet connection.

The most popular G Suite applications are:

»
Goo gle * Used for text documents
Docs * Comparable to MS Word
e : —
|
Goo gle * Used for spreadsheets
Sheets e Comparable to MS Excel
”
h
* Used for presentations
* Comparable to MS PowerPoint
o
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Getting Started in Google Sheets

Google Sheets is the equivalent of Microsoft Excel, an online
spreadsheet application, which allows you to create and E

manage collaborative spreadsheets from any device with an

internet connection. There are two ways to create a new
Google Sheet. You can create a new sheet from Google Drive

or from the Google Sheets application. GOOQ|€ SheetS

Creating a New Document from Google Drive:

1. Access your Google Drive either from the website drive.google.com or from Google’s
homepage (www.google.com), click on the 3x3 grid of dots and select Google Drive.

2. Clickonthe - new button and select Google Sheets, then choose ‘Blank
spreadsheet.

Creating a New Spreadsheet from Google Sheets:

1. Onyour computer, open a web browser (e.g. Chrome) and open the Google Sheets
home screen at sheets.google.com.

2. To access Google Sheets, log into your Gmail account by entering your username and
password.

3. On the top left of the window, under ‘File’ click ‘New’ then ‘Spreadsheet’ to open a
new blank spreadsheet.
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Once you have successfully opened a new blank document and named the document, it will
automatically be saved and you will be able to access the file at any time from your Google
Drive.

To name or rename your spreadsheet, at the top of the page, click ‘Untitled spreadsheet,
enter a new title, and press the Enter key on your keyboard.

Untitled spreadshee
File Edit View Insert Format Data Tocls Addons Help

- ~ & P 0% ~ $ % .0 00 123~ Default(Ari. - ]

-

T —

Navigating Google Sheets

Common Spreadsheet Terms:

Each file in Google Sheets is called a
spreadsheet. Each spreadsheet 2
contains individual worksheets in

(F8 )

which to enter your data.

Every spreadsheet is made up of cells. A
cell is a singular data pointin a
spreadsheet. Each cell is located at the
intersection of a specific column and
row.

(1~ - R Y I O T ¥ -

10

A set of cells that run vertically is called a column. A column in a spreadsheet is always
identified by alphabet letters (A, B, C ...). A set of cells that run horizontally is called a row. A
row in a spreadsheet is identified by numbers (1, 2,3 ...).
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A cell is identified by a cell address, which is a combination of the column name and the row
number. For example, the address of the cell located at the intersection of column B and row
2is B2.

A selection of cells extending across a row, column, or both simultaneously is called a range.

Functions are built in operations from the application, which are used to calculate cell, row,
column, or range values, and manipulate data for analysis.

Formulas are the combination of functions, cells, rows, columns and ranges used to obtain a
specific result.

Google Sheets has many features similar to Microsoft Excel. At the top of the window, similar
to Google Docs, Google Sheets has a toolbar with various spreadsheet formatting options.
Use the toolbar at the top of the window and the various tabs to choose the appropriate
option. To see the name of a command found on the toolbar, hover your mouse point over
the button and the command name will pop up.

Copy Cell
Print Formatting Font Settings Cell Outlines Advanced
1 L | 1 e —
& e ~ T 5 % g .00 123~  Aral - 10 - B I S A. - -H- -1+ coBMY-Z
I | i L
Undo / Redo Format Font Styling Cell Data
Number as... Alignment

Spend a couple of minutes exploring the various tools found on the toolbar.
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Features of Google Sheets

Adding Contentinto a Cell:

To insert content into a cell, click on the desired cell to make it the active cell. You will know
which cell is active based on the blue outline around the cell. Once you have a cell selected,
start typing your content. Press the ENTER key on your keyboard to confirm your entry and
move down to the next row or TAB to move to the right in the same row. The content appears
in the cell and in the formula bar. Similar to Microsoft Excel, you may copy content from one

cell and paste in other cells:

e Select the cells you would like to copy.

e Press Ctrl + c to copy. You can also use the copy button on the tool bar.

e Select the cell(s) where you would like to paste the content, and press Ctrl + v to paste.

To Insert and Delete Rows and Columns:

e Toinserta column, select the column adjacent

to where you wish to insert the new column and
right click on the column heading.

e From the drop-down menu, select an option:
Insert 1 right or Insert 1 left. A new column will
be inserted as selected.

e Toinsertarow, select the row adjacent where
you wish to insert the new row and right-click
on the row heading.

Frontier Kids Cookie Sales |

File Edit View Inset Format Data Tools Add-ons

& e A~ T 0§ % 0 .00 123-  Trebuchet... -

B

Address
1167 Coberly Way Orlando. FL 32804

1605 Bing St. Apt. 2 Orlando. FL 32803
54 N. Kentucky Ave. Orlando, FL 32804
200 Markham St Orlando, FL 32804

3788 Lake Wales Lane Orlando. FL 32804
919 Banyan Blvd. Orlando. FL 32804
1600 Bing St. Apt. 1 Orlando. FL 32803
1605 Bing St. Apt. 2 Orlando, FL 32803

- Paste

Paste special

Insert 1 left
Insert 1 right
Delete column
Clear column

Hide column

Resize column.

Sort sheet A —

Help  All changes saved in Drive

u - B I 5 A ¥

E

Mint Whistles M|
1

1
3

z 10

e From the drop down menu, select an option: Insert 1 above or Insert 1 below. A new

row will be inserted as selected.
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To Merge Cells:

To merge: Select the cells you want to merge and
click on the button for Merge on the toolbar.

To unmerge: Select the cell you want to unmerge
and click on the drop-down arrow on the Merge

button and select Unmerge.

These two tools are also available in the drop-down
menu of the Format tab on the toolbar.

Freezing the Header Row

jes saved in Drive

E

Lemon Drops

f 5 A. . H-EH-

1
'T'l'_""l'

Merge all

Merge horizontally

M

Mint Y

1 1

Unmerge @ 1

When you “freeze” the first row in place it means that as you scroll through the spreadsheet,
the first row always remains visible. Freezing the header row allows you to always see the
header categories when you are scrolling through a long list.

There are two ways to freeze rows:

1. Click VIEW>FREEZE>1 ROW in the navigation bar to lock the first row in place.

2. Hover the dark grey bar in the top left of the spreadsheet.

- o

b rowss

" Grdires
a

=) SpreauanBasdcs Tutorial [ ]
File Edt Vigw lnsert Fomet Da Addors Help  All charges saved o Drive
Franza - A
P 4

= | el b WY - E

E

i

row z

Or grab this dark grey bar and drag it between row 1 and 2

Select to "Freeze" the first

F o

Penagnail
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Number Formats:

Applying number formats to the data in your spreadsheet makes it easy to read and use.
Number formats help in understanding exactly what type of data is entered in the
spreadsheet (e.g. currency, percentages, dates).

To apply number formats, highlight the cells that contain the numbers. Select the desired
formatting option by clicking on one of the quick number-formatting commands
found on the toolbar. [s « o o

0
- T

There are additional format choices in the number formatting drop-down menu.

& e o~ P s % 0 .00 123  Arial - 10 - B
21 v"  Autematic
A B Plain text

1| 21
2 33 Number 1,000 12
3 16 i
P 99 Percent 10.12%
5 15 Scientific 1.01E+03
8 1
7 Financial 1.000.12
: Currency $1,000.12
»
10 Date 8/26/2008
i i
- Time 3:5%:00 PM
12
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Introduction to Google Slides

Google Slides is a cloud-based presentation application, which
allows you to create, edit, and collaborate on slideshow
presentations wherever you are.

Google Slides

Creating a New Presentation from Google Drive

1. Access your Google Drive either from the website drive.google.com or from Google’s
homepage (www.google.com) and then click on the 3x3 grid of dots and select
Google Drive.

2. Clickonthe - new button and select Google Slides, then choose ‘Blank
presentation.’

Creating a New Presentation from Google Slides

1. Onyour computer, open a web browser (e.g. Chrome) and open the Google Slides
home screen at slides.google.com.

2. You will need to log into your Gmail account in order to access Google Sheets.

3. On the top left of the window, under ‘File’ click ‘New,’ then ‘Presentation’ to open a
new blank presentation.

Once you have successfully opened a new blank document and named the document, it will

automatically be saved and you will be able to access the file at any time from your Google
Drive.
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To name or rename your Google Slides

Presentation, click ‘Untitled presentation,” at =

the top of the page, enter a new title and press
the Enter key on your keyboard.

Navigating Google Slides

Google Slides has many features similar to Microsoft
PowerPoint. At the top of the window, like Google
Docs and Google Sheets, Google Slides has a
toolbar with various presentation slide formatting
options. Use the toolbar at the top of the window
and the various tabs to choose the appropriate
options for creating a professional presentation. To
see the name of a command found on the toolbar,

Clickto add title

Title slida

Tile and Iwe columns

Clickia add itle

Main point

X%

Big number

Section header

Title only

Click o add sl

Sectlon lille and
deacription

Blank

Title and body

One column text

Caption

hover your mouse point over the button and the command name will pop up.

File Edit View Insert Slide Format

+ - -

Arrange Tools

Q k[T« @- \

Table

E Background...

Help

Spend a couple of minutes exploring the various tools found on the toolbar.

Features of Google Slides

Adding New Slides and Slide Layout

When you insert a new slide, it will have placeholders to show where your text can be placed.

Google Slides has different layouts for these placeholders, depending on what type of

information you want to include on your slide. Whenever you create a new slide, choose the

slide layout that best fits your content.
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To add a new blank slide, click on the + sign in the top left-hand corner of the window. To
choose a different layout for your slide, click on the drop-down menu next to the + sign to

open the options for different slide layouts.

If you would like to change the layout of your existing slide, click the ‘Slide’ tab and select
‘Apply layout’ to open a window of slide layout options.

Alternatively, you may right click on the slides within your presentation and choose either
New Slide or Duplicate Slide to add additional slides.

Organizing Slides

Your Google Slides presentation
can contain as many slides as
you need. On the left of your
window, the Slide Navigation
pane allows you to duplicate,
rearrange and delete slides
within your presentation.

If you want to copy and paste a
slide quickly, you can duplicate
it. To duplicate a slide, select the
slide, right-click the mouse, and
choose ‘Duplicate slide’ from the
menu.

To rearrange the order of your slide, click and drag the

Abraham Lincoln

11/19/1863

Click to add notes

XK Cut
selected slide up or down in the Slide Navigation pane to the @ Copy
desired position. () Paste

If you want to remove a slide from your presentation, you can
delete it. Select the slide you want to delete, then press the
‘delete’ or ‘backspace’ key on your keyboard.

Peletz

[Ch Pastz without formatting Crrl+Shift

Ctrl
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Selecting and Changing Themes:

Themes are pre-designed layouts and color schemes for your
presentations that can be adjusted and customized to fit your
preference. Select a theme that fits the type of presentation
you are creating.

One of the first things you should do when you open your new
presentation is to select your theme choice from the window on
the right-hand side. If you change your theme choice after
creating your presentation, the formatting of your slides will be
changed and may need to be adjusted or corrected.

To change your theme after getting started, click the Theme
button on the toolbar.

AN

=

Background Layoutv Theme  Transition

Importing New Themes

Themes

In this presentation

Click to add title

Click to add subtitle

Simple Light

Click to add title

10

Simple Dark

Click to add title

Import theme

The Themes Panel contains the default themes for Google Slides. In order to import additional
themes, click the ‘Import theme’ button on the Themes Panel. A new window will open,

which allows you to upload a PowerPoint presentation, which contains the theme you want

to import.

Once you select the PowerPoint presentation, a new window will open with the theme for
you to select and import. Once imported, the theme will be applied to the entire presentation
and the layout menu will have difference layouts available for selection.
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Adding Transitions and Animations to the Slides

Presentations do not have to be a series of static slides. In Google Slides, you have the option
to add animations and transitions to entire slides. A transition can be as simple as fading to
the next slide, or it can be a flashier effect. Objects can be animated to move or fade in and
out of the slide, adding emphasis and movement to your presentation.

Adding Transitions

Select a slide and in the toolbar, click ‘Slide’ then
‘Change transition.’ This will open the Transition
Pane, where you may choose the type and speed of
transition that you wish to use.

Click the ‘Play’ button after you select your
transition type to preview the transition. If you want
to apply the same transition to all slides, click the

‘Apply to all slides’ button.

Adding Animations

From the Transition menu, you also have the option to
create visual effects to animate text and objects in your
slides.

Open the Change Transitions Pane from the menu bar,
click on an object you want to animate and then click
‘Add Animation.” Choose the type of animation, start
condition, and speed of the animation. Selecting the box
‘By paragraph’ will allow you to animate your lists one
line at a time. Repeat these steps for additional
animations you want to create for other objects.

L B-Q N\ - Transitions e
v Slide: Dissolve
Dissolve (/)
Fast
Apply to all slides
+ Select an object to animate
Play
Transitions X
> Slide: Dissolve
Fade in (On click) ®

Fade in

On click

[ sy paragraphh

Slow Medium

Fast

+ Add animation

Play
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Adding Media and Shapes:

The Insert tab in Google Slides provides options to insert various features to your

presentation;

¢ Image - Insert an image by browsing your computer
for previously saved images, the web, Google Drive
and more.

e Text Box - Create a text box by clicking and holding
down the mouse pointer as you drag the mouse to
create your text box. Let go of the mouse pointer to
confirm your selection.

e Video - Insert a video file by searching YouTube,
pasting a URL, or browsing your Google Drive.

e Shape - Select one of the categories to bring up a list

of available shapes. Insert the desired shape by clicking the mouse pointer and

2.

W

inzert Format Slide

M image
1] Text box

W Video

2 Shape

Tzhble

[&] Chart

= Diagram

A
Y

Word art

Line

Arrange

=

holding it down as you drag the mouse across the screen. Let go of the mouse pointer

to confirm your selection.

e Table - Create a table by selecting the number of columns and rows desired.

e Chart - Insert a chart into your presentation by selecting the type of chart and/or

browsing for an excel file with a chart.

In addition to using the Insert tab, you may insert text boxes, images, shapes and lines by

selecting the command from the available buttons

on the toolbar. Once selected, click and hold the

mouse pointer, dragging the box or shape to the k ! - Q_I \ ¥

appropriate size and when satisfied, let go of the
mouse pointer to confirm.
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Once inserted, you can resize your image or shape by selecting it and dragging one of the
anchor point and letting go of the mouse point when satisfied. Keep the shape or image the
same aspect ratio by holding down the shift key as you resize it.

Presenting Your Slideshow

To present your slideshow, click the ‘Present’ button at the top right-hand side of the window.
This will open the presentation on your computer screen. Click the mouse pointer to navigate

through the slides and transitions.

Speakers Notes

When you are building your presentation, there is a box entitled ‘Click to add speaker notes,’
at the bottom of the screen. This space is for you to add any presentation notes about each of
the slides in your presentation. When you are presenting, the notes will be displayed for your

reference in the Presenter View.

Presenter View

The Presenter View shows your slideshow in a separate window from the window that shows
what the audience can see. The Presenter View allows you to see which slide is next, the
presenter notes and unlocks some additional features as well.

To enable Presenter View, click the drop down
menu on the ‘Present’ button at the top right
corner of your window. You will then be able to
select ‘Presenter View.’ Your presentation will start
with your presenter view in a separate window.

M) Presenter view

=

-

Present from meginning

[l Present ~

& Share
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|n the Presenter VieW' there is a @ Presenter view - Untitled presentation - Goegle Slides - Google Chrome =3 =] |
@® about:blank
running clock to keep track of the
00:00:08 Pause Reset AUDIENCE TOOLS ~ SPEAKER NOTES

length of your presentation. You
will also have access to all of your Side2 :
slides in your deck in case you
decide to jump ahead in the
presentation or skip a slide. The
Presenter View also enables the Q
& A Feature.

Slide 2 of 2

The Q & A Feature

The Q & A feature allows the presenter to take questions from the audience during the
presentation without interruption. During your presentation, a link will be displayed at the
top of your presentation for audience members to go to type their questions. They do not
need to have a Google account to do this and are also able to remain anonymous.

o, |
L=}

Asking as WHW Education O Ask anonymeusly 0/300

CANCEL

Once an audience member types a

a a a a a @ about:blank
question, it will pop up within your
. 00:00:16 Pause Reset AUDIENCE TOOLS ~ SPEAKER NOTES
Presenter View, but not on the screen,
which the audience sees. This feature siae2 : Esn o5 290 900 SI/AFUMS
gives the audience the opportunity to ask
. . ® WHW Education
their questions and allows the presenter = TV
. . Can you please elaborate on point number 5?
time to provide a response when ready o S0
without interrupting the presentation. PRESENT
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Practice

The more you utilize Google Drive and the various G Suite applications, the more familiar you
will become with the functions. Spend some time building your resume or a to-do list for your
job search in Google Docs. Google has many wonderful templates available for your use free
of charge. Below are some additional training resources for continued development of your G
Suite skills.

e Official Google Tools Training
o https://support.google.com/a/users/answer/9282959?hl=en (Google Sheets
Training)

o https://support.google.com/docs/table/25273?hl=en&utm source=zapier.com&ut

m_medium=referral&utm campaign=zapier (Google Sheets function list)
o https://support.google.com/a/users/answer/9282488 (Google Slides Training)

As the official source of training on Google Sheets and Google Slides, this is a great resource
for learning the basics. These sites contain guides, cheat sheets, tips and even guides on
switching from Microsoft Office to Google Tools. The Google Sheets function list contains a
handy cheat sheet for all the functions available to use in Google Sheets.

e Tiller Money
o https://www.tillerhg.com/learn-google-sheets/

Tiller Money provides additional free resources for training in using Google Sheets.

e The Edublogger
o https://www.theedublogger.com/google-slides/

This is a great beginner’s guide to getting a foundation in using Google Slides.

¢ Lynda.com Online Training
o https://www.lynda.com/Google-Sheets-tutorials/8612-0.html
o https://www.lynda.com/Google-Slides-tutorials/Google-Slides-Essential-
Training/724784-2.html

While not a free resource, Lynda.com (now LinkedIn Learning) has a large range of in-depth
tutorials and trainings.
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